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Intended Use 

The EGFR Plus RGQ PCR Kit is a research use only real-time PCR test intended for the qualitative 
detection and identification of mutations in exons 18, 19, 20, and 21 of the epidermal growth 
factor receptor (EGFR) gene (1) in DNA samples extracted from plasma or formalin-fixed 
paraffin-embedded (FFPE) tumor tissue. 

The EGFR Plus RGQ PCR Kit is further intended for the semi-quantitative measurement of 
somatic mutations in exons 18, 20, and 21 of the EGFR gene in DNA samples extracted from 
plasma. 

The EGFR Plus RGQ PCR Kit is to be used by trained personnel in a professional laboratory 
environment for research use only. It is not intended for diagnostic procedures. 

Intended User 

This kit is intended for professional use. 

The product is to be used only by personnel specifically instructed and trained in molecular 
biology techniques and familiar with this technology. 
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Description and Principle 
Summary and explanation 

The EGFR Plus RGQ PCR Kit is a real-time PCR (polymerase chain reaction) test for the detection 
of 42 mutations in the EGFR gene using ARMS (Amplification Refractory Mutation System) (2, 
3) and PCR clamp technologies for the qualitative detection and identification of mutations in 
the EGFR gene; exons 18, 19, 20, and 21 (Table 1). The kit allows the semi-quantification of 
G719X (with X = A, S or C; exon 18), T790M (exon 20), C797Sa and C797Sb (exon 20), 
S768I (exon 20), L858R (exon 21), and L861Q (exon 21) in DNA samples extracted from 
plasma. In summary: 

 G719X in exon 18 (detects and semi-quantifies G719S, G719A, or G719C, but does not 
distinguish between them) 

 28 deletions in exon 19 (detects the presence of any of the 28 deletions but does not 
distinguish between them)  

 S768I, T790M, C797Sa and C797Sb in exon 20 (detects and semi-quantifies all four 
mutations, but does not distinguish between C797Sa and C797Sb) 

 Five insertions in exon 20 (detects the presence of any of the five insertions, but does not 
distinguish between them) 

 L858R and L861Q in exon 21 (detects and semi-quantifies the two mutations) 

The methods used are highly selective and, depending on the total amount of DNA present, 
enable detection of a low percentage of mutant DNA in a background of wild-type genomic 
DNA. These selectivity and detection limits can be compared to technologies such as 
dyeterminator sequencing. 
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Table 1. List of mutations and COSMIC identities 

 Exon Mutation COSMIC ID* Base change  

 18 G719A 6239 c.2156G>C  

 G719S 6252 c.2155G>A 

 G719C 6253 c.2155G>T 

19 Deletions 26038 c.2233_2247del15 

  13550 c.2235_2248>AATTC 

  6223 c.2235_2249del15 

  6225 c.2236_2250del15 

  18427 c.2237_2257>TCT 

  6220 c.2238_2255del18 

  12367 c.2237_2254del18 

  12384 c.2237_2255>T 

  12678 c.2237_2251del15 

  13551 c.2235_2252>AAT 

  13552 c.2235_2251>AATTC 

  12386 c.2237_2252>T 

  12416 c.2237_2253>TTGCT 

  12728 c.2236_2253del18 

  12422 c.2238_2248>GC 

  12382 c.2239_2248TTAAGAGAAG>C 

  6218 c.2239_2247delTTAAGAGAA 

  12387 c.2239_2258>CA 

  12370 c.2240_2257del18 

  12403 c.2239_2256>CAA 

  6255 c.2239_2256del18 

  12383 c.2239_2251>C 

  12419 c.2238_2252>GCA 

  6210 c.2240_2251del12 

  23571 c.2238_2252del15 

  12369† c.2240_2254del15 
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  13556 c.2253_2276del24 

  12385 c.2235_2255>AAT 

20 S768I 6241 c.2303G>T 

 Insertions 12376 c.2307_2308insGCCAGCGTG 

  12378 c.2310_2311insGGT 

  12377 c.2319_2320insCAC 

  13428 c.2311_2312insGCGTGGACA 

  13558 c.2309_2310AC>CCAGCGTGGAT 

 T790M 6240 c.2369C>T 

 C797Sa 6493937 c.2389T>A 

 C797Sb 5945664 c.2390G>C 

21 L858R 6224 c.2573T>G 

 L861Q 6213 c.2582T>A 

  * COSMIC: Catalogue Of Somatic Mutations In Cancer: http://cancer.sanger.ac.uk/cosmic 
† According to the new COSMIC database, due to the similarities in sequence after the deletion has occurred, deletion 

6254 is combined with deletion 12369. 

Principle of the procedure 

The EGFR Plus RGQ PCR Kit uses real-time PCR for the detection of 42 mutations in the EGFR 
gene (exons 18, 19, 20, and 21) and the semi-quantification of G719X (with X = A, S or C; 
exon 18), T790M (exon 20), C797Sa and C797Sb (exon 20), S768I (exon 20), L858R (exon 
21), and L861Q (exon 21). The EGFR Plus RGQ PCR Kit will test genomic DNA (gDNA) 
extracted from FFPE tumor tissue and circulating cell-free DNA (ccfDNA) extracted from plasma 
samples using the Rotor-Gene® Q 5plex HRM instrument. Data analysis and result interpretation 
are performed manually using Rotor-Gene Q software version 2.3 or later and the instructions 
provided in this Instructions for Use (Figure 1). 

  

http://cancer.sanger.ac.uk/cosmic
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Figure 1. EGFR Plus RGQ PCR Kit workflow. For non-DSP extraction kits, see “Materials Required but Not Provided”, 
page 21. 

Technology 

The use of qPCR permits the accurate detection of PCR products during the exponential phase 
of the PCR amplification process. qPCR data can be rapidly obtained, without post-PCR 
processing, by real-time detection of fluorescent signals during PCR cycling. 

The EGFR Plus RGQ PCR assays exploit the qPCR oligonucleotide hydrolysis principle. During 
PCR, forward and reverse primers hybridize to a specific sequence. Another dye-linked 
oligonucleotide is contained in the same mix. This probe, which consists of an oligonucleotide 
labeled with a 5' reporter dye and a downstream 3' dye-free quencher, hybridizes to a target 
sequence within the PCR product. qPCR analysis with hydrolysis probes exploits the 5'→3' 
exonuclease activity of the Thermus aquaticus (Taq) DNA polymerase. When the probe is 
intact, the proximity of the reporter dye to the quencher results in suppression of the reporter 
fluorescence, primarily by Förster-type energy transfer. 

During PCR, if the target of interest is present, both forward and reverse primers specifically 
anneal and flank the probe. The 5'→3' exonuclease activity of the DNA polymerase cleaves 
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the probe between the reporter and the quencher only if the 3 oligonucleotides hybridize to 
the target. The probe fragments are then displaced from the target and polymerization of the 
strand continues. The 3' end of the probe is blocked to prevent extension of the probe during 
PCR (Figure 2). This process occurs in every cycle and does not interfere with the exponential 
accumulation of product. 

The increase in fluorescence signal is detected only if the target sequence is complementary 
to the primers and probe and hence amplified during PCR. 

 
Figure 2. Reaction principle. 
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In the EGFR Plus RGQ PCR Kit, mutation-specific reactions use ARMS (amplification-refractory 
mutation system) and clamp designs to detect, identify, and semi-quantify (when applicable) 
mutations in DNA extracted from FFPE and plasma.  

ARMS 

Amplification-refractory mutation system (ARMS) exploits the ability of Taq DNA polymerase 
to distinguish between a matched and a mismatched base at the 3' end of a PCR primer. 
When the primer is fully matched, the amplification proceeds with full efficiency. When the 3' 
base is mismatched, only low-level background amplification may occur. Therefore, a mutated 
sequence is selectively amplified, even in samples where the majority of the DNA does not 
carry the mutation (Figure 3). 

 
Figure 3. Identification of specific mutation by ARMS PCR. WT: Wild type. Q–F: Double-dye probe. D: Forward and 
reverse primers. 
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PCR clamp 

This method is used to detect several variants localized in the same hotspot (e.g., EGFR 
deletions in exon 19). The clamp assay combines standard primers and probe with an 
additional oligonucleotide that is 3'-blocked by the addition of a phosphate group, in order 
to prevent PCR elongation. The clamp oligonucleotide, as well as the primers and probe, are 
specific to the wild-type sequence (PCR clamping). When the PCR template contains the wild-
type sequence, the clamp hybridizes before the primer, due to a higher Tm leading to no or 
low amplification. In contrast, when a mutated sequence is present, the clamp cannot bind, 
which allows primer annealing and amplification (Figure 4). 

 

Figure 4. Mutation detection by clamp technology. WT: Wild type. Q–F: Double-dye probe. D: Forward and reverse 
primers. 
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Kit format and assays 

Mutation assays 

Four primer and probe mixes are supplied in the EGFR Plus RGQ PCR Kit: 

• T790M and L861Q 
• Insertions (exon 20) and G719X 
• L858R and C797S 
• Deletions (exon 19) and S768I 

All primer and probe mixes, when combined with the PCR Master Mix, allow the detection of 
targets that are labeled with carboxyfluorescein (FAM™), CAL Fluor® Red 610 and an internal 
control labeled with hexachlorofluorescein (HEX™). 

Internal control assay 

The internal amplification control reaction, labeled with HEX, is used to assess the total 
amplifiable EGFR DNA template in a mutated and a non-mutated (wild type) sample (Figure 
5), and to identify reaction failures due to suboptimal DNA input, or the presence of inhibitory 
substances in the sample matrix. This internal amplification reaction amplifies a region of 
exon 2 of the EGFR gene. The primers and probe have been designed to avoid any known 
EGFR polymorphisms. 
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Figure 5. EGFR exon 2 internal control (IC) detection. WT: Wild-type. Q–F: Double-dye probe. D: Forward and reverse 
primers. 

Water for sample dilution (Dil.) 

The EGFR Plus RGQ PCR Kit contains Nuclease-Free Water to be used for gDNA sample 
dilution. 

Controls 

Each PCR run must contain a positive control (PC) and a negative control (NTC) for each of 
the four assays.  

Positive control (PC) 

Each run must contain a positive control in tubes 1–4. The EGFR Plus RGQ PCR Kit contains 
one EGFR Positive Control (PC) to be used as the template in the positive control reaction. The 
positive control results will be assessed to ensure that the kit performs within the predefined 
acceptance criteria. 
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No template control (NTC) 

Each run must contain a negative control (no template control; NTC) in tubes 5–8. The EGFR 
Plus RGQ PCR Kit contains water for the NTC to be used as the “template” for the no template 
control. The no template control is used to assess any potential reagent and environment 
contamination. 
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Materials Provided 

The contents of the EGFR Plus RGQ PCR Kit are sufficient for 24 samples (the kit contains 
sufficient reagents for up to four qPCR runs of six samples per run, including run controls). 

Kit contents 

 EGFR Plus RGQ PCR Kit   (24)  
 Catalog no.  874601  

 Number of reactions  24  

 Color      Identity Tube ID Volumes  

 Green T790M & L861Q Mix EGFR T790M & L861Q Mix 280 µL  

Yellow Insertions & G719X Mix EGFR Insertions & G719X Mix 280 µL 

Purple L858R & C797S Mix EGFR L858R & C797S Mix 280 µL 

Orange Deletions & S768I Mix EGFR Deletions & S768I Mix 280 µL 

Red EGFR Positive Control EGFR Positive Control 190 µL 

Blue PCR Master Mix EGFR PCR Master Mix 2 × 940 µL 

Colorless Water for NTC NTC 1.9 mL 

Colorless Water for sample dilution Dil. 1.9 mL 

  

Platform and software 

The EGFR Plus RGQ PCR Kit is specifically designed to be used with Rotor-Gene Q instruments* 
with fluorescent channels for cycling green, yellow, and red with Rotor-Gene Q software 
version 2.3 or later in Open mode.  

 

 
* Ensure that instruments and equipment have been checked and calibrated according to the manufacturer’s 

recommendations. 
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Materials Required but Not Provided 
Additional reagents 

 Deparaffinization Solution (cat. no. 19093 or 939018) for manual and automated 
gDNA preparation from FFPE samples  

 QIAsymphony® DSP DNA Mini Kit (cat. no. 937236)* for automated gDNA preparation 
from FFPE samples 

 QIAsymphony DSP Circulating DNA Kit (cat. no. 937556) for automated ccfDNA 
preparation (from plasma)  

 QIAamp® DSP DNA FFPE Tissue Kit (cat. no. 60404)† for manual gDNA preparation 
from FFPE samples 

 QIAamp DSP Circulating Nucleic Acid Kit (cat. no. 61504)‡ for manual ccfDNA 
preparation from plasma samples 
Note: Materials required but not provided for the DNA extraction kits listed above are 
detailed in the respective kit handbooks. 

 RNase A (cat. no. 19101) for manual or automated gDNA sample preparation from 
FFPE samples 

 Buffer ATL (cat. no. 939016) for the deparaffinization protocol used with the 
QIAsymphony DSP DNA Mini Kit (cat. no. 937236) or QIAsymphony DNA Mini Kit 
(cat. no. 931236) 

  

 
* The QIAsymphony DNA Mini Kit (cat. no. 931236) can be used if the QIAsymphony DSP DNA Mini Kit (cat. no. 

937236) is not available. 
† The QIAamp DNA FFPE Tissue Kit (cat. no. 56404) can be used if the QIAamp DSP DNA FFPE Tissue Kit (cat. no. 

60404) is not available. 
‡ The QIAamp Circulating Nucleic Acid Kit (cat. no. 55114) can be used if the QIAamp DSP Circulating Nucleic Acid 

Kit (cat. no. 61504) is not available. 
 



 

18 EGFR Plus RGQ PCR Kit Instructions for Use   03/2023 

Consumables and general laboratory equipment 

 Dedicated pipettes* (adjustable) for sample preparation  
 Dedicated pipettes* (adjustable) for PCR Reaction Mix preparation  
 Dedicated pipettes* (adjustable) for dispensing of template DNA 
 Nuclease-free, aerosol-resistant, sterile PCR pipette tips with hydrophobic filters (pipette 

tips with aerosol barriers are recommended to help prevent cross-contamination) 
 Vortex mixer* 
 Benchtop centrifuge* with rotor for 0.5 mL, 1.5 mL, and 2.0 mL reaction tubes (capable 

of attaining 13,000–14,000 rpm)  
 DNase, RNase, DNA-free, sterile 1.5 or 2.0 mL microcentrifuge tubes for preparing 

DNA and PCR reaction mixes  
 Strip Tubes and Caps, 0.1 mL, for the Rotor-Gene Q 5plex HRM instrument (cat. no. 

981103 or 981106) 
 DNA quantification instrument 
 Sample tubes (e.g., 2 mL Sarstedt® tube [cat. no. 72.693]) for automated gDNA 

preparation (from FFPE blocks). Compatible primary and secondary tube formats are 
listed at www.qiagen.com/goto/dspdnakits 

 Single-use, sterile scalpel for manual and automated gDNA preparation (from FFPE 
section on slide sample)  

 Sterile phosphate-buffered saline (PBS, may be required for topping up plasma sample 
volumes)  

  

 
* Prior to use, ensure that instruments have been checked and calibrated according to the manufacturer’s 

recommendations. 

http://www.qiagen.com/goto/dspdnakits
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Equipment for automated sample preparations 

 QIAsymphony SP instrument* (cat. no. 9001297) and provided accessories  
Note: Required accessories are detailed in the respective extraction kit handbooks. 

 QIAsymphony software version 4.0 or later  
 QIAsymphony Tissue_LC_200_DSP protocol for automated gDNA preparation from FFPE 

samples (see www.qiagen.com/qiasymphony-dsp-dna-kits) 
 QIAsymphony circDNA_2000_DSP protocol for automated ccfDNA preparation from 

plasma samples (see www.qiagen.com/qiasymphony-dsp-circulating-dna-kit) 
 

Equipment and materials for qPCR 

 Rotor-Gene Q instruments* with fluorescence channels for Cycling Green, Cycling Red, 
and Cycling Yellow (detection of FAM, CAL Fluor Red 610 and HEX, respectively)  

 Rotor-Gene Q software version 2.3 (or later) 
 Loading Block 72 × 0.1 mL Tubes, aluminum block (cat. no. 9018901) for manual 

reaction setup with a single-channel pipette  
 72-Well Rotor (cat. no. 9018903), Locking Ring 72-Well Rotor (cat. no. 9018904), and 

Rotor Holder (cat. no. 9018908) 
 

 

 

 

https://www.qiagen.com/us/products/diagnostics-and-clinical-research/sample-processing/qiasymphony-dsp-dna-kits-us/
https://www.qiagen.com/shop/sample-technologies/dna/genomic-dna/qiasymphony-dsp-circulating-dna-kit/#resources
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Warnings and Precautions 

Please be aware that you may be required to consult your local regulations for reporting 
serious incidents that have occurred in relation to the device to the manufacturer and/or its 
authorized representative. 

Safety information 

When working with chemicals, always wear a suitable lab coat, disposable gloves, and 
protective goggles. For more information, please consult the appropriate safety data sheets 
(SDSs). These are available online in convenient and compact PDF format at 
www.qiagen.com/safety, where you can find, view and print the SDS for each QIAGEN kit 
and kit component. 

 All chemicals and biological materials are potentially hazardous. Specimens and 
samples are potentially infectious and must be treated as biohazardous materials. 

 Discard sample and assay waste according to your local safety procedures. 
 For safety information regarding the QIAsymphony SP instrument and the Rotor-Gene Q 

instrument, refer to the user manual supplied with the instrument.  

Precautions 

Use of EGFR Plus RGQ PCR Kit requires good laboratory practices, including traceability, 
maintenance of equipment dedicated to molecular biology, and compliance with applicable 
regulations and relevant standards. 

This kit is intended for research use only and not for use in diagnostic procedures. Reagents 
and instructions supplied in this kit have been tested for optimal performance. 

The user should always pay attention to the following: 

https://www.qiagen.com/gb/support/qa-qc-safety-data/safety-data-sheets/
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 The test is for use with FFPE and plasma specimens. 
 Use extreme caution to prevent contamination of samples and reagents with EGFR- 

positive material (i.e., Positive Control) or potentially EGFR-positive material 
(i.e., specimens to be tested).  

 Change the scalpels between samples when scraping the tissue. 
 Use separate, dedicated pipettes for DNA extraction/preparation, setting up PCR 

reaction mixes (pre-PCR reaction mix preparation) and adding DNA template into 
PCR tubes.  

 Use fresh aerosol-resistant pipette tips for all pipetting steps to avoid cross-
contamination of the samples and reagents. Use extreme caution to prevent DNA or 
PCR product carryover contamination which may result in a false-positive signal. 

 Preparation and dispensing of reaction mixes must be carried out in a dedicated 
area separate from the DNA preparation area where no DNA matrices (DNA, 
plasmid, or PCR products) are introduced. In this same area, add water in NTC tubes 
and close them. 

 Add DNA template in a separate zone, preferably in a separate room, with 
dedicated equipment (pipettes, tips, etc.). 

 Rotor-Gene Q tubes must not be opened after the PCR run has finished. This is to 
prevent laboratory contamination with post-PCR products.  

 EGFR Plus RGQ PCR Kit reagents should be protected from light, temperature, and 
repeated thawing and freezing, otherwise the kit performance may be altered.  

 Frozen components are thawed completely at room temperature (15–25°C) (or in a 
refrigerator (2–8°C) and protected from light. Check regularly to see whether the 
material is already thawed. 

 All chemicals a nd biological materials are potentially hazardous. Specimens and 
samples are potentially infectious and must be treated as biohazardous materials. 

 Reagents for the EGFR Plus RGQ PCR Kit have been optimally diluted. Do not dilute 
reagents further as this may result in a loss of performance.  
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 Do not use reaction volumes (reaction mix plus sample) of less than 25 µL since this will 
increase the risk of a false-negative result.  

 All reagents supplied in the EGFR Plus RGQ PCR Kit are intended to be used solely with 
the other reagents supplied in the same EGFR Plus RGQ PCR Kit.  

 Do not substitute the reagents in the EGFR Plus RGQ PCR Kit or between EGFR Plus RGQ 
PCR Kit lots, as this may affect performance. 

 Do not use expired or incorrectly stored components. 
 Caution must be observed to ensure correct sample testing and analysis with emphasis 

on eliminating wrong sample entry, loading error, pipetting error, and placing the PCR 
strip tubes into the appropriate positions of the 72-well rotor. 

 Make sure the samples are handled in a systematic way to ensure correct identification 
and traceability. 

 Use extreme caution to prevent contamination by DNase, which may cause degradation 
of the template DNA. Use nuclease-free labware (e.g., pipettes, pipette tips, reaction 
vials) and wear gloves when performing the assay.  
Note: The product is to be used only by experienced laboratory personnel familiar with 
laboratory procedures and the Rotor-Gene Q 5plex HRM instrument. 
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Reagent Storage and Handling 

Attention should be paid to expiration dates and storage conditions printed on the box and 
labels of all components. Do not use expired or incorrectly stored components. 

Shipping condition 

The EGFR Plus RGQ PCR Kit is shipped on dry ice and must still be frozen on arrival. If any 
component of the EGFR Plus RGQ PCR Kit is not frozen on arrival, the outer packaging has 
been opened during transit, or the shipment does not contain a packing note, or the reagents, 
please contact one of the QIAGEN Technical Service Departments or local distributors (visit 
www.qiagen.com).  

For shipping conditions relating to the DNA extraction kits and associated reagents to be used, 
refer to the respective kit handbooks. 

Storage conditions 

The EGFR Plus RGQ PCR Kit should be stored immediately upon receipt at −30 to −15°C in a 
constant-temperature freezer and protected from light. 

Note: All fluorescently labeled probes in the reaction mix reagents are light sensitive. 
Protect reaction mix reagents from light to avoid photo bleaching. 

Repeated freezing and thawing should be avoided. Reagents should ideally be subjected to 
a maximum of 4 freeze–thaw cycles.  

For storage and handling information relating to the DNA extraction kits and associated 
reagents to be used, refer to the respective kit handbooks. 

http://www.qiagen.com/
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Stability 

When stored under the specified storage conditions, the EGFR Plus RGQ PCR Kit is stable until 
the stated expiration date on the label. Avoid unnecessary freeze–thawing of the contents of 
the kit.  

Once opened, reagents can be stored in their original packaging at −30 to −15°C until the 
stated expiration date shown on the packaging. The total time prior to run once the PCR 
reactions are set up should not exceed 24 hours if stored in the refrigerator (2–8°C; this time 
includes both the PCR setup and storage). 

For stability information relating to the DNA extraction kits and associated reagents to be used, 
refer to the respective kit handbooks. 

Attention should be paid to expiration dates and storage conditions printed on the box and 
labels of all components. Do not use expired or incorrectly stored components. 
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Sample Storage and Handling 

Sample material is human genomic DNA extracted from FFPE tumor tissue or circulating cell-
free DNA (ccfDNA) extracted from K2 EDTA plasma. 

Samples must be transported according to standard pathology methodology to ensure 
specimen quality. 

Note: All samples must be treated as potentially infectious material.  

Note: For optimal use of the reagents in the EGFR Plus RGQ PCR Kit, samples should be 
batched. If samples are tested individually, this will use more reagents and reduce the 
number of samples that can be tested with the kit. 

FFPE samples 

Tumor samples are non-homogeneous and data from a tumor sample may not be concordant 
with other sections from the same tumor. Tumor samples may also contain non-tumor tissue. 
DNA from non-tumor tissue would not be expected to contain mutations detected by the EGFR 
Plus RGQ PCR Kit.  

To prepare tissue samples for gDNA extraction: 

 Standard formalin fixation and paraffin-embedding procedures should be used. Refer to 
the relevant extraction kit handbook for more details.  

 Using a microtome, cut 5 µm serial sections from the paraffin block and mount them on 
glass slides. Use a trained individual (e.g., a pathologist) to assess a Hematoxylin & 
Eosin (H&E)-stained section to confirm that there is tumor present. The stained sections 
must not be used for DNA extraction. 

 The starting material for gDNA purification is sections of FFPE tissue (ideally freshly cut).  
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 Store all FFPE blocks and slides at room temperature. FFPE sections mounted on glass 
slides may be stored at ambient temperature for up to 1 month prior to DNA extraction.  

Plasma samples 

Use standard laboratory procedures to prepare plasma from K2 EDTA whole blood samples. 
Refer to the relevant extraction kit handbook for more details.  

If fresh plasma is used for nucleic acid extraction on the same day, store at 2–8°C until further 
processing. For longer-term storage, keep plasma frozen at −30 to −15°C or −90 to −65°C. 
It is recommended to use aliquots, to avoid freeze–thawing of plasma samples. Repeated 
freeze–thawing leads to denaturation and precipitation of proteins, which may result in 
reduced yields of circulating cell-free nucleic acids. 

Genomic DNA and circulating cell-free DNA samples 

Genomic DNA extracted from FFPE tissue and circulating cell-free DNA extracted from plasma 
should be stored at 2–8°C for short-term storage (up to 24 hours) and −30 to −15°C (or −90 
to −65°C) if long-term storage is required. Avoid unnecessary freeze–thawing of the extracted 
gDNA and ccfDNA. Frozen eluates must not be thawed more than three times. 
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Procedure 
Protocol: DNA extraction and preparation 

Things to do before starting 

 Make sure the operator is trained in using the instruments and extraction kits needed for 
DNA extraction and sample preparation. If required, instrument training can be provided 
upon installation (see “Ordering Information”, page 91). 

 Read the “Materials Required but Not Provided” section of each extraction kit handbook 
to identify the accessories required for each procedure: 

 QIAsymphony DSP DNA Mini Kit (cat. no. 937236) for automated gDNA preparation 
(from FFPE samples)  

 QIAsymphony DSP Circulating DNA Kit (cat. no. 937556) for automated ccfDNA 
preparation (from plasma samples)  

 QIAamp DSP DNA FFPE Tissue Kit (cat. no. 60404) for manual gDNA preparation (from 
FFPE samples) 

 QIAamp DSP Circulating Nucleic Acid Kit (cat. no. 61504) for manual ccfDNA 
preparation (from plasma samples) 

Protocol: gDNA extraction from FFPE samples 

The EGFR Plus RGQ PCR Kit has only been tested in combination with QIAGEN 
Deparaffinization Solution (cat. no. 19093 or 939018) for FFPE section deparaffinization with 
the following DNA extraction kits:  

 QIAsymphony DSP DNA Mini Kit (cat. no. 937236) for automated extraction 
 QIAamp DSP DNA FFPE Tissue Kit (cat. no. 60404) for manual extraction 
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Important points before starting  

Applicable to automated extraction and manual extraction protocols: 

 Make sure the DNA extraction reagents have not expired and have been transported 
and stored under the correct conditions.  

 Do not use expired or incorrectly stored components.  
 Between one and four FFPE tissue sections, each with a thickness of 10 µm, or between 

two and eight sections with a thickness of up to 5 µm can be combined in one 
preparation.  

 Use only the Deparaffinization Solution for FFPE deparaffinization, according to the 
procedure, “Pretreatment protocol for use with the QIAsymphony DSP DNA Mini Kit” on 
page 30 or “Protocol: Pretreatment protocol for use with the QIAamp DSP DNA FFPE 
Tissue Kit” on page 33. 
Note: Deparaffinization Solution is not supplied with extraction kits and should be 
ordered separately (see “Ordering Information”, page 91). 

 Use RNase A to minimize RNA content (included in procedure “Protocol: FFPE section 
deparaffinization with QIAGEN Deparaffinization Solution” on page 30). 
Note: RNase A is not supplied with extraction kits and should be ordered separately (see 
“Ordering Information”, page 91). 

 Sample dilution may be necessary prior to qPCR testing (see “Protocol: gDNA 
quantification and normalization”, page 38) or for storage.  

 DNA isolated from FFPE samples is usually of lower molecular weight than DNA from 
fresh or frozen samples. The degree of fragmentation depends on the type and age of 
the sample and the conditions used for fixation. 

 For DNA storage after extraction, see “Genomic DNA and circulating cell-free DNA 
samples”, page 26. 
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Protocol: Automated gDNA extraction from FFPE samples using the 
QIAsymphony SP 

If using the QIAsymphony DSP DNA Mini Kit (cat. no. 937236) for automated extraction, 
carry out the DNA extraction according to the instructions in the handbook, noting the 
following: 

 Use only the Deparaffinization Solution for FFPE deparaffinization according to the 
procedure, “Pretreatment protocol for use with the QIAsymphony DSP DNA Mini Kit”, 
page 30. 
Note: Deparaffinization Solution is not supplied with the extraction kits and should be 
ordered separately (see “Ordering Information”, page 91). 

 Select the Tissue_LC_200_V7_DSP protocol on the QIAsymphony SP instrument (for more 
details, refer to the QIAsymphony SP Protocol Sheet Tissue_LC_200_V7_DSP protocol) 

 Use 50 µL elution volume. 
 For any supplementary information concerning the QIAsymphony SP instrument, refer to 

the user manual supplied with the instrument. 

Protocol: Manual gDNA extraction from FFPE samples  

If using the QIAamp DSP DNA FFPE Tissue Kit (cat. no. 60404) for manual extraction, carry 
out the DNA extraction according to the instructions in the handbook, noting the following: 

 Use only the Deparaffinization Solution for FFPE deparaffinization according to the 
procedure “Protocol: Pretreatment protocol for use with the QIAamp DSP DNA FFPE 
Tissue Kit”, page 33. 
Note: Deparaffinization Solution is not supplied with the extraction kits and should be 
ordered separately (see “Ordering Information”, page 91). 

 Use 50 µL elution volume. 
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Protocol: FFPE section deparaffinization with QIAGEN 
Deparaffinization Solution 

Pretreatment protocol for use with the QIAsymphony DSP DNA Mini Kit 

This pretreatment protocol is for use with the QIAsymphony DSP DNA Mini Kit (for automated 
extraction) and is based on the QIAsymphony SP Protocol Sheet Tissue_LC_200_V7_DSP 
protocol (Method 1: deparaffinization using the Deparaffinization Solution). 

Important points before starting  

 Equilibrate all buffers to room temperature and equilibrate Deparaffinization Solution to 
20–25°C.  

 QIAsymphony magnetic particles co-purify RNA and DNA if both are present in the 
sample. In order to minimize RNA content in the sample, add RNase A to the sample at 
the step indicated in the pretreatment protocol below. 

 Deparaffinization Solution, RNase A and Buffer ATL are not supplied with the 
QIAsymphony DSP DNA Mini Kit and must be ordered separately (see “Ordering 
Information”, page 91). 

Things to do before starting  

 Preheat a thermomixer or shaker-incubator to 56°C for use in step 7.  

 Check ATL buffer for white precipitate. If necessary, dissolve precipitate according to the 
protocol described in QIAsymphony SP Protocol Sheet Tissue_LC_200_V7_DSP protocol. 
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Procedure 

Starting with FFPE blocks only 

1. Using a scalpel, trim excess paraffin off the sample block. Cut between one and four 
sections of 10 µm thickness or between two and eight sections of 5 µm thickness. 
Note: If the sample surface has been exposed to air, discard the first 2–3 sections. 

2. Immediately place the section(s) in a 2 mL sample tube compatible with the sample tube 
carrier of the QIAsymphony SP (not supplied; e.g., Sarstedt, cat. no. 72.693). 

3. Continue with step 4 below (“For all samples”). 

Starting with FFPE sections on slides only 

1. Put 1 drop of Deparaffinization Solution on each slide using dedicated pipettes for 
sample preparation. 

2. Scrape off the sample material with a single-use, sterile scalpel to collect the entire tissue. 
Place the aggregates in a 2 mL sample tube compatible with the sample tube carrier of 
the QIAsymphony SP (not supplied; e.g., Sarstedt, cat. no. 72.693). 

3. Continue with step 4 below (“For all samples”). 

For all samples 

4. Add 200 µL Buffer ATL to the sections. 

5. Add 20 µL proteinase K. 

Note: Use proteinase K from the enzyme rack of the QIAsymphony DSP DNA Mini Kit. 

6. Add 160 µL or 320 µL Deparaffinization Solution (see Table 2) and mix by vortexing. 
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Table 2. Volume of Deparaffinization Solution required 

 Section thickness Number of sections Volume of Deparaffinization Solution  

 5 µm 1–4 160 µL  

 5–8 320 µL 

10 µm 1–2 160 µL 

 3–4 320 µL 

 7. Place the tube in a ThermoMixer or shaker-incubator and incubate at 56°C for 1 hour 
with shaking at 1000 rpm until the tissue is completely lysed. 

Note: Lysis time varies depending on the tissue type processed. For most tissues, lysis is 
completed within 1 hour. If lysis is incomplete after 1 hour as indicated by the presence 
of insoluble material, lysis time can be prolonged or insoluble material can be pelleted 
by centrifugation. Overnight lysis is possible and does not affect the preparation. 

8. Incubate at 90°C for 1 hour. 

Note: The incubation at 90°C in Buffer ATL partially reverses formaldehyde modification 
of nucleic acids. Longer incubation times or higher incubation temperatures may result in 
more fragmented DNA. If using only one heating block, leave the sample at room 
temperature after the 56°C incubation until the heating block reaches 90°C. 

9. To minimize RNA content in the sample, add 2 µL RNase A (100 mg/mL) to the lower 
phase and incubate for 2 minutes at room temperature before continuing with step 10. 
Allow the sample to cool to room temperature before adding RNase A. 

10. Centrifuge at full speed for 1 minute at room temperature. 

11. Carefully transfer tubes (containing both phases) to the sample carrier of the 
QIAsymphony SP. 

12. Proceed to extraction following the instructions in the QIAsymphony DSP DNA Mini Kit 
Handbook (use 50 µL elution volume). 
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Protocol: Pretreatment protocol for use with the QIAamp DSP DNA 
FFPE Tissue Kit 

This pretreatment protocol is for use with the QIAamp DSP DNA FFPE Tissue Kit (for manual 
extraction) and is based on “QIAGEN Supplementary Protocol: Purification of genomic DNA 
from FFPE tissue using the QIAamp DNA FFPE Tissue Kit and Deparaffinization Solution”. 

Important points before starting  

 Perform all centrifugation steps at room temperature.  
 Equilibrate all buffers to room temperature; equilibrate Deparaffinization Solution to 

20–25°C. 
 Deparaffinization Solution, RNase A and Buffer ATL are not supplied with the QIAamp 

DSP DNA FFPE Tissue Kit and must be ordered separately (see “Ordering Information”, 
page 91). 

Things to do before starting  

 Preheat a thermomixer or heated orbital incubator to 56°C for use in steps 6 and 10. If a 
thermomixer or heated orbital incubator is not available, a heating block or water bath 
can be used instead.  

 If Buffer AL or Buffer ATL contain precipitates, dissolve precipitate according to the 
protocol described in QIAamp DSP DNA FFPE Tissue Kit. .  

 Ensure that Buffer AW1 and Buffer AW2 have been prepared according to the 
instructions in the QIAamp DSP DNA FFPE Tissue Kit Handbook. 
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Procedure 

Starting with FFPE blocks only 

1. Using a scalpel, trim excess paraffin off the sample block. Cut into sections 5–10 µm 
thick. 

Note: If the sample surface has been exposed to air, discard the first 2–3 sections. 

2. Immediately place the section(s) in a 1.5 mL or 2 mL microcentrifuge tube (not supplied). 

3. Continue with step 4 below (“For all samples”). 

Starting with FFPE sections on slides only 

1. Put 1 drop of Deparaffinization Solution on each slide using dedicated pipettes for 
sample preparation. 

2. Scrape off the sample material with a scalpel to collect the entire tissue. Put the 
aggregates in a 1.5 mL or 2 mL microcentrifuge tube (not supplied). 

3. Continue with step 4 below (“For all samples”). 

For all samples 

4. Add 160 µL or 320 µL Deparaffinization Solution (Table 3) and vortex vigorously for 
10 seconds. 

Table 3. Volume of Deparaffinization Solution required 

 Section thickness Number of sections Volume of Deparaffinization Solution  

 5 µm 1–4 160 µL  

 5–8 320 µL 

10 µm 1–2 160 µL 

 3–4 320 µL 
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5. Centrifuge briefly to collect the sample in the bottom of the tube. 

6. Incubate at 56°C for 3 minutes and allow to cool at room temperature. 

7. Add 180 µL Buffer ATL, and mix by vortexing. 

8. Centrifuge for 1 minute at 11,000 x g (10,000 rpm). Two phases appear (blue and 
clear). 

9. Add 20 µL proteinase K to the lower, clear phase. Mix gently by pipetting up and down. 

10. Incubate at 56°C for 1 hour (or until the sample has completely lysed). 

11. Incubate at 90°C for 1 hour. 

The incubation at 90°C in Buffer ATL partially reverses formaldehyde modification of 
nucleic acids. Longer incubation times or higher incubation temperatures may result in 
more fragmented DNA.  

Note: If using only one heating block, leave the sample at room temperature after the 
56°C incubation in step 10, until the heating block has reached 90°C for step 10.  

12. Briefly centrifuge the 1.5 mL tube to remove drops from inside the lid. 

13. Transfer the lower, clear phase into a new 2 mL microcentrifuge tube. 

14. Add 2 µL RNase A (100 mg/mL) and incubate for 2 minutes at room temperature. 

15. Continue with step 12 (addition of Buffer AL) of the QIAamp DSP DNA FFPE Tissue Kit 
Handbook (use 50 µL elution volume). 
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Protocol: ccfDNA extraction from plasma samples 

The EGFR Plus RGQ PCR Kit has been tested in combination with the following DNA extraction 
kits:  

 QIAsymphony DSP Circulating DNA Kit (cat. no. 937556) for automated ccfDNA 
extraction (from plasma samples)  

 QIAamp DSP Circulating Nucleic Acid Kit (cat. no. 61504) for manual ccfDNA 
extraction (from plasma samples) 

Important points before starting  

Applicable to automated extraction and manual extraction protocols: 

 Make sure the DNA extraction reagents have not expired and have been transported 
and stored under the correct conditions.  

 Do not use expired or incorrectly stored components.  
 Starting material for ccfDNA purification should be plasma prepared from K2 EDTA 

whole blood samples. Samples can be either fresh or frozen (provided that they have not 
been frozen and thawed more than once). 

 The concentration of circulating cell-free nucleic acids in biological fluids such as plasma 
is usually low and varies considerably between individuals. Therefore, ccfDNA extracted 
from plasma samples will not be quantified nor normalized (no dilution), and is used 
directly in the qPCR reaction. 

 For DNA storage after extraction, refer to the section “Genomic DNA and circulating 
cell-free DNA samples”, page 26. 
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Protocol: Automated ccfDNA extraction from plasma samples using 
the QIAsymphony SP 

If using the QIAsymphony DSP Circulating DNA Kit (cat. no. 937556) for automated 
extraction, carry out the DNA extraction according to the instructions in the handbook, noting 
the following: 

 Select the circDNA_2000_DSP_V1 protocol on the QIAsymphony SP instrument (for 
protocol details, refer to QIAsymphony SP Protocol Sheet circDNA_2000_DSP_V1) 
Important: The recommended sample volume for the circDNA_2000_DSP is 2 mL. 
However, we recommend starting with 2.4 mL to prevent any extraction failure during 
initial pipetting, as specified in the “Troubleshooting Guide” of the QIAsymphony DSP 
Circulating DNA Kit Handbook. If insufficient sample is available, add sterile PBS (not 
supplied) to the sample up to the required sample volume before loading the sample.  

 Use a 60 µL elution volume  
 For any supplementary information concerning the QIAsymphony SP instrument, refer to 

the user manual supplied with the instrument. 

Protocol: Manual ccfDNA extraction from plasma samples  

If using the QIAamp DSP Circulating Nucleic Acid Kit (cat. no. 61504) for manual purification, 
carry out the DNA extraction according to the instructions in the handbook noting the 
following: 

 Purification of circulating nucleic acids is performed from 2 mL of plasma. 
 A vacuum manifold (e.g., the QIAvac 24 Plus with the QIAvac Connecting System) and 

a vacuum pump capable of producing a vacuum of −900 to −800 mbar (e.g., QIAGEN 
Vacuum Pump) are required for the protocol.  

 Use a 60 µL elution volume. 
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Protocol: gDNA quantification and normalization 

Things to do before starting 

If using automated extraction procedures, check the “Validity of result” column for each sample 
on the QIAsymphony SP result file once the run is finished: 

 Valid status: Proceed to gDNA quantification. 
 Unclear status: Can be processed depending on the origin of the flag (for details 

regarding possible origins of “unclear” flagging, refer to the QIAsymphony SP/AS User 
Manual). 

 Invalid status: Sample is rejected. Repeat the extraction step. 

Procedure 

gDNA extracted from FFPE samples should be quantified. 

If measured concentration is less than 4 ng/µL, the sample must be re-extracted with more 
sections (to a maximum of eight sections of 5 µm or four sections of 10 µm). 

If measured concentration is above 6 ng/µL, the sample must be diluted to 5 ng/µL using the 
Water for sample dilution provided in the EGFR Plus RGQ PCR Kit, according to the formula: 

𝐶𝐶𝐶𝐶 × 𝑉𝑉𝑉𝑉 = 𝐶𝐶𝐶𝐶 × 𝑉𝑉𝑉𝑉 

Where 
Ci: Initial concentration of the extracted gDNA 
Cf: Final concentration to be targeted = 5 ng/µL 
Vf: Final volume needed to perform a EGFR Plus RGQ PCR run (i.e., 20 µL + extra-
volume for pipetting error) 
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Vi: Initial volume of the extracted gDNA to be pipetted and diluted with the Water 
for sample dilution provided in the EGFR Plus RGQ PCR Kit (Water volume to add = 
Vf – Vi) 

 
Each PCR reaction is optimized for 25 ng gDNA diluted in a final sample volume of 5 µL. As 
each sample is tested with the four EGFR reaction mixes, a total of 100 ng per tested sample 
is needed. 

Note: Make sure the correct elution buffer is used to calibrate the quantification 
instrument. 

ccfDNA extracted from plasma samples should not be quantified. Each PCR reaction is 
optimized for 5 µL of pure extracted ccfDNA. As each sample is tested with the four EGFR 
reaction mixes, a total of 20 µL per tested sample is needed. 
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Protocol: EGFR mutation assessment by qPCR on Rotor-Gene Q 
instrument 

Important points before starting 

 Make sure the operator is trained in using the instruments for qPCR. If required, 
instrument training can be provided upon installation (see “Ordering Information”, page 
91). 

 Read “Precautions”, page 20, and become familiar with all components of the kit prior 
to use. 

 The EGFR Plus RGQ PCR Kit must be run on a Rotor-Gene Q 5plex HRM instrument* 
using the Rotor-Gene Q software version 2.3 or later. 

 Take time to familiarize yourself with the Rotor-Gene Q 5plex HRM instrument and the 
Rotor-Gene software before starting the protocol. See the user manuals for the instrument 
and the Rotor-Gene Q software for details. 

 If you are using automated extraction procedures, check the “Validity of result” column 
for each sample on the QIAsymphony SP result file once the run is finished, see Protocol: 
gDNA quantification and normalization, page 38. 

 If you are using gDNA extracted from FFPE, the sample should be quantified and diluted 
to 5 ng/µL, see “Protocol: gDNA quantification and normalization”, page 38. 

 If you are using ccfDNA extracted from plasma, samples should be used undiluted. 

  

 
* Ensure that instruments and equipment have been checked and calibrated according to the manufacturer’s 

recommendations. 
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Setting up the qPCR 

Using the EGFR Plus RGQ PCR Kit, it is recommended to test six DNA samples in the same 
experiment to optimize use of the controls and reaction mixes. However, up to 16 samples 
can be tested in the same experiment. 

Things to do before starting 

 Cool the Loading Block (72 x 0.1 mL tubes) in a refrigerator (2–8°C). 
 Before each use, thaw all necessary components. 

Note: Do not exceed 1 hour at room temperature for the thawing step to avoid any 
material degradation. If more time is required, store components at 2–8°C for up to 
8 hours. 

 Clean the bench area dedicated for the PCR mix preparation to reduce the risk of 
template or nuclease contamination. 

 Vortex the tubes containing controls, Primers and Probes mixes and PCR master mix  
(3–5 seconds) and then centrifuge briefly before use. 

Procedure 

1. Prepare the four PCR Reaction Mixes in 1.5 mL or 2 mL tubes (not provided), i.e., mix 
each Primers and Probes mix (T790M & L861Q Mix, Insertions & G719X Mix, L858R & 
C797S Mix or Deletions & S768I Mix) with PCR Master Mix, according to the number of 
samples to be processed. 

The volume required for each kit component to make the Reaction Mixes is shown in 
Table 4. The final PCR reaction volume is 25 µL after addition of 5 µL sample DNA or run 
control template. Extra volume is included to compensate for pipetting variation and to 
allow preparation of enough reaction mix for planned number of test samples and 
controls, e.g., six samples plus two controls. 
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Table 4. Preparation of Reaction Mixes 

 Component 1 reaction (µL) 8 + 1 reactions (µL)*  

 EGFR Primers and Probes Mix 7.5 67.5  

PCR Master Mix 12.5 112.5 

Total volume of Reaction Mix 20 180 

Reaction Mix distribution 20 µL per tube 

Test sample distribution 5 µL per tube 

Total volume per reaction 25 µL 

 * An extra reaction volume is included to compensate for pipetting error: one extra well for up to 10 wells and two 
extra wells for up to 20 wells. 

2. Return all the EGFR Plus RGQ PCR Kit components to the freezer to avoid any material 
degradation. 

3. Vortex Reaction Mixes for 3–5 seconds and centrifuge briefly. 

4. Place the PCR strip tubes on a cooled Loading Block (72 x 0.1 mL tubes) and dispense 
20 µL EGFR Reaction Mixes per strip tube following the loading block setup shown in 
Figure 6. 

Note: It is recommended to dispense the 20 µL of the reaction mix by reverse pipetting. 
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Figure 6. Loading block setup for an experiment with the EGFR Plus RGQ PCR Kit, testing six samples. Positions 1–32 
are as follows. PC: EGFR Positive Control; NTC: No template control (water). Sample 1 (S1) to Sample 6 (S6): DNA 
samples. Reaction Mixes: EGFR T790M & L861Q Mix, EGFR Insertions & G719X Mix, EGFR L858R & C797S Mix, 
EGFR Deletions & S768I Mix. All remaining positions  are empty wells. 

Note: Both the FFPE and plasma DNA samples can be run in the same experiment. 

5. Add 5 µL of Water for NTC into the designated NTC tubes (Figure 6) to obtain a total 
volume of 25 µL. Mix gently by pipetting up and down. Close all tubes containing NTC. 

6. Vortex and briefly centrifuge DNA samples and EGFR Positive Control (PC). Then, add 
5 µL sample or PC template into the corresponding tubes (Figure 6) to obtain a total 
volume of 25 µL. Mix gently by pipetting up and down. 

7. Close all tubes and check that no bubbles are present at the bottom of the tubes. 

Note: Change tips between each template addition to avoid contamination. 
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Protocol: Preparing the Rotor-Gene Q 5plex HRM instrument 

8. Place a 72-well rotor on the Rotor-Gene Q 5plex HRM instrument rotor holder. 

9. Fill the rotor with strip tubes according to the assigned positions, starting at position 1, as 
shown in Figure 7. 

Note: Make sure the first tube is inserted into position 1 and the strip tubes are placed in 
the correct orientation and positions as shown. 

10. All unused positions should be filled with empty capped strip tubes. 

Note: We recommend keeping the four positive controls in positions 1 to 4 and the four 
no template controls in positions 5 to 8 to facilitate the analysis. 

 

 

Figure 7. Rotor setup for an experiment with the therascreen EGFR Plus RGQ PCR Kit. From position 1 PC: EGFR Positive 
Control. NTC: No template control (water). PPM 1: EGFR T790M & L861Q Mix. PPM 2: EGFR Insertions & G719X 
Mix. PPM 3: EGFR L858R & C797S Mix. PPM 4: EGFR Deletions & S768I Mix. Sample 1 to Sample 6: DNA samples. 
Note: All remaining positions  should be filled with empty tubes. 
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11. Attach the locking ring. 

12. Load the Rotor-Gene Q 5plex HRM instrument with the rotor and locking ring. Close the 
instrument lid. 

Starting the qPCR run 

13. Double-click the Rotor-Gene Q Software version 2.3 (or later) icon on the desktop 
connected to the Rotor-Gene Q instrument to open the software (Figure 8). 

 
Figure 8. Rotor-Gene Q desktop icon. 

14. Select Empty run, then click New (Figure 9). 

 

 
Figure 9. Starting a new run. 1: “Empty run”. 2: “New run”. 
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15. In the “New Run Wizard” window, select 72-Well Rotor from the “Rotor Type” list and 
check the Locking Ring Attached box. Click Next. 

 
Figure 10. New Run Wizard. 1: “72-Well Rotor”. 2: “Locking Ring Attached”. 3: “Next”. 

16. In the “Reaction Volume (µL)” field, set the value to 25. Ensure that the “Sample Layout” 
field reads 1,2,3….Click Next (Figure 11). Optionally, enter notes in the “Notes” field. 

 
Figure 11. Adding notes. 1: “Operator”. 2: “Notes”. 3: “Reaction volume”. 4: “Sample layout”. 5: “Next”. 



 

  EGFR Plus RGQ PCR Kit Instructions for Use    03/2023 47 

17. Click Edit Profile (Figure 12). 

 
Figure 12. Edit Profile. 
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18. In the “Edit Profile” window, click Insert after > New Hold at Temperature (Figure 13). 
Then, set the following values in these fields: 

 Hold Temperature: Set the value to 95°C. 
 Hold Time: Set the value to 10 minutes. 

 
Figure 13. Edit Profile. 1: “Insert after”. 2: “New Hold at Temperature”. 3: “Hold Temperature”. 4: “Hold Time”. 

 

19. Click Insert after > New Cycling. 
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20. In the “This cycle repeats” field, set the value to 45 times. Remove the automatic third 
elongation step that was added as default. Then, select the first step and set the value to 
95°C for 15 seconds (Figure 14). 

 

Figure 14. Edit profile. 1: “New cycling”. 2: Cycle repeats 45 times. 3: First step timing. 
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21. Highlight the second step and set the value to 60°C for 60 sec (Figure 15). 

 
Figure 15. Edit Profile second step. Set the temperature to 60ºC. 
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22. Click Not Acquiring to enable data acquisition during this step. In the “Acquisition” 
dialog box, select Green, Red, and Yellow from the “Available channels” list, then click > 
to move them to the “Acquiring Channels” list. Click OK (Figure 16). 

 

 
Figure 16. Edit Profile. 1: “Not Acquiring”. 2: Selection of acquiring channels. 3: Channels acquired. 4: “OK”. 
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23. Ensure the that acquiring parameter is set to Acquiring to Cycling A on Green, Red, 
Yellow (Figure 17). 

 
Figure 17. Edit Profile. “Acquiring to Cycling A”. 
 

24. In the next window, click Gain Optimisation (Figure 18). 

 
Figure 18. Gain Optimisation. 
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25. In the “Auto-Gain Optimisation Setup” dialog box, click Optimise Acquiring (Figure 19). 
“Channel settings” are then displayed for each channel. Click OK to accept these values 
for both channels according to the parameters defined in Table 5. 

Table 5. Channel settings for the “Optimise Acquiring” step 

 Parameter Instruction  

 Perform Optimisation before first acquisition Yes  

Perform Optimisation at 60 degrees at beginning of run No 

Temperature 60ºC for 1 minute 

 
 Channel Green 

(FAM Green) 

Yellow  

(HEX) 

Red  

(CAL Fluor Red 610) 

 

 Tube position 1 1 1  

Min. reading 5 5 5 

Max. reading 10 10 10 

Gain minimum −10 −10 −10 

Gain maximum 10 10 10 

  

 
Figure 19. Gain Optimisation settings. 
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26. Check the Perform Optimisation before 1st Acquisition option, then click Close to return 
to the “New Run wizard” window (Figure 20). 

 
Figure 20. Gain Optimisation. 1: “Perform Optimisation before 1st Acquisition“. 2: “Close”. 
 

27. Click Next. To save the template in an appropriate location, click Save Template.  

28. Review the summary, then click Start Run to save the run file and start the run (Figure 21). 

 
Figure 21. Start run. 
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29. After the run starts, a new window appears that lets you enter sample names during the 
run or click Finish and enter them at a later time. 

Sample Types & Layout 

Sample names can be added during the run or after run is complete. Sample type and selected 
column must be specified to ensure correct analysis parameters are applied. Analysis pages 
are required for each reaction mix, failure to do so may lead to incorrect results. 

1. To define sample layout, click Samples to open the “Edit Samples” window (Figure 22). 

2. One “Analysis Page” is required for each reaction mix. Click New to create a total of 
four pages. 

Note: Navigation between “Pages" can be done using the arrows (Figure 22). 

3. “Analysis Pages" should be named to match the reaction mixes: 1) T790M & L861Q 
Mix; 2) Insertions & G719X Mix; 3) L858R & C797S Mix; 4) Deletions & S768I Mix 
(Figure 22). 

Note: Ensure that Synchronize Pages box is unchecked. 
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Figure 22. Opening the Edit Sample Window and creating Analysis Pages. 1: Samples button to open edit sample 
window. 2: New button to create analysis pages. 3: Navigation arrows. 4: Name box for analysis page containing 
reaction mix name. 5: Synchronize pages box (ensure this is unchecked). 

4. On each page, enter the sample names including PC, NTC and samples. 

5. Specify sample type according to Table 6 and select Yes for the tubes containing the 
reaction mix relevant for the analysis page (Figure 23). 

Note: Only tubes containing the relevant reaction mix should be selected on each page 
(see Figure 6 for sample setup). 

6. In tubes not containing the relevant reaction mix, “Sample Type” should be set to None 
and “Selected” should be set to No (Figure 23). This ensures only appropriate tubes are 
analyzed and may lead to incorrect results if performed incorrectly (e.g., on Analysis 
Page, 1 (T790M & L861Q Mix), the Type for tube 1 should be defined as PC and tubes 
2–4 should be defined as None). 
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Table 6. Sample types for layout setup in the Rotor-Gene Q 

 Sample type Description  

 None No sample in that position  

NTC No template control 

Negative Control Negative control 

Positive Control Positive control 

Unknown Unknown sample to be analyzed 

Standard 
Standard values are used to construct a standard curve to calculate 
unknown sample concentrations 

Calibrator (RQ) A calibrator is assigned a value of 1 and all other sample concentrations 
are calculated relative to this sample 
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Figure 23. Example of sample layout for analysis pages. 1: Name box for analysis page containing reaction mix name.  
2: Type is set for the relevant tubes (Table 7) Selected is set to Yes. 3: Type set to None for tubes not containing named 
reaction mix. 4: Synchronize pages box is unchecked. 
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Table 7. Analysis pages, one analysis page should be created for each reaction mix 

 Reaction Mix Name Analysis Page No Tube selected for analysis  

 T790M & L861Q Mix 1 1 (PC), 5 (NTC), Sample(s) 9, 13, 17, 21,25, 29  

Insertions & G719X Mix 2 2 (PC), 6 (NTC), Sample(s) 10,14, 18, 22, 26, 30 

L858R & C797S Mix 3 3 (PC), 7 (NTC), Sample(s) 11, 15, 19, 23, 27, 31 

Deletions & S768I Mix 4 4 (PC), 8 (NTC), Sample(s) 12, 16, 20, 24, 28, 32 

T790M & L861Q Mix 1 1 (PC), 5 (NTC), Sample(s) 9, 13, 17, 21,25, 29 

 

Tubes containing this reaction mix should be selected for analysis and the type should be 
defined. All other tubes should have type set to None. Failure to do so may invalidate the run. 

 
7. After the run is complete, analyze the data according to “Interpretation of Results” 

page 60, as appropriate. 
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Interpretation of Results 

After the run is complete, analyze the data as follows. 

Software analysis settings 

1. Open the appropriate run file using the Rotor-Gene Q series software (version 2.3 or 
later). 

2. If the samples are not named before starting the run, click Edit Samples. 

3. Insert the sample names in the “Name” column and select the appropriate sample type 
(as detailed in Sample Types & Layout). 

Note: Leave the names of any empty wells blank, select None as sample type, and 
change the “Selected” column to No. Incorrect sample type and selection can lead to 
incorrect analysis parameters being applied. 

4. Go to “Analysis” tab and start with Cycling A. Green (Figure 23). 
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Figure 24. “Analysis” tab for Cycling A. 1: “Cycling A. Green”. Once the correct layout has been used, each of the 
four reaction mixes will be displayed in the analysis for each channel. 

5. Analyze the parameters selection as follows (Figure 24). 

5a. Click the name of the EGFR reaction mix to be analyzed. Check that the Dynamic 
Tube and Slope Correct options are selected. Click Take Off Adjustment and adjust 
the cycle to be used as take-off point. 

Note: If analysis for individual channels is not present, refer to section “Sample Types” 
and “Layout” and ensure “Analysis” pages are set up correctly) 

 
5b. If take-off point is calculated before cycle 15, use cycle 20 as the take-off point. 
5c. Click Outlier Removal, set the “NTC threshold” field to 10%, and check that the 

Reaction Efficiency Threshold option is disabled (Figure 25). 
5d. Click Linear Scale and set the threshold to 0.03. 
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Figure 25. Setting the Dynamic Tube, Slope Correct, Linear Scale and Threshold. 1: “Dynamic Tube” and “Slope 
Correct”. 2:  “Take Off Adj.” and “Outlier Removal”. 3: “Take Off Point Adjustment”. 4: “Threshold”. 5: “Scale”. 

 
Figure 26. Setting Outlier Removal. 

6. Repeat the analysis using the same parameters for Cycling A. Red and Cycling A. Yellow. 

7. For each well, check visually the amplification curves to assess exponential amplification 
occurred and not an artefact. 

8. To interpret the PCR results, click File > Save As > Excel Analysis Sheet to export the run 
report as .csv data. 
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9. To record all PCR results including the amplification curves, click Report. Select the report 
to record and click Quantitation (FullReport) to export as .mht files.  

10. Ensure that the raw data (.rex file) have been recorded and proceed to “Data analysis”, 
page 64. 

11. Unload the Rotor-Gene Q instrument and discard the strip tubes according to your local 
safety regulations.  
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Data analysis 

The data analysis is performed manually following the instruction described in this section. 

The PCR cycle at which the fluorescence from a particular reaction crosses a threshold value 
is defined as the CT value. The Rotor-Gene Q software interpolates fluorescence signals 
between any two recorded values. CT values can therefore be any real number (not limited to 
integers) within the range 0 to 45. 

CT values for all controls and samples from the 4 EGFR assays, i.e., EGFR T790M & L861Q 
Mix, EGFR Insertions & G719X Mix, EGFR L858R & C797S Mix, EGFR Deletions & S768I 
Mix, in Green (FAM), Red (CFR610), and Yellow (HEX) channels are extracted from the run 
report (.csv file) or from the single assay reports (.mht file). The .mht files also contain 
amplification curves of each single assay. The Rotor-Gene Q .rex file is kept as a record of the 
run raw data.  

The following steps are required to determine the EGFR mutation status of a sample: 

 The qPCR controls of the four EGFR assays, i.e., EGFR T790M & L861Q Mix, EGFR 
Insertions & G719X Mix, EGFR L858R & C797S Mix, EGFR Deletions & S768I Mix, must 
be checked for validity (see ”qPCR run validity”, page 65).  

 The internal controls of test samples must be checked for validity (see “Validity of test 
sample”, page 67). 

 EGFR mutant call for each valid sample is then determined (see “EGFR mutant call of test 
samples”, page 68). 

 Semi-quantitative analysis can be performed for the mutations: G719X (A, C or S), 
S768I, T790M, C797S (a or b), L858R and L861Q (see “Semi-quantitation of ccfDNA 
using the Rotor-Gene Q”, page 70). 
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qPCR run validity 

For the EGFR qPCR run to be valid, all EGFR assays must be valid, meaning that the CT values in 
the Green (FAM), Red (CFR610) and Yellow (HEX) channels for the controls (positive control and 
no template control) must comply with the run control validity criteria (Table 8). 

Table 8. Run control validity criteria 

  
Fluorescence channel 

 
EGFR Reaction Mix  

Positive Control (PC)  
CT validity range 

No template control (NTC)  
CT validity criteria 

 

 Green (FAM) T790M & L861Q  25.74; 32.74 

No amplification 

 

Insertions & G719X  25.06; 32.06 

L858R & C797S  23.49; 30.49 

Deletions & S768I  26.15; 33.98 

Red (CFR610) T790M & L861Q  21.30; 28.30 

Insertions & G719X  24.56; 32.38 

L858R & C797S  22.88; 29.88 

Deletions & S768I  24.26; 31.86 

Yellow (HEX) T790M & L861Q  

19.89; 26.89 >40.00 or no 
amplification 

Insertions & G719X  

L858R & C797S  

Deletions & S768I  

  If one or several run controls are invalid according to the criteria defined above, the run is 
considered invalid and should be repeated with the 4 EGFR Reaction Mixes. If one or several 
samples are invalid, the samples concerned should be retested with the 4 EGFR Reaction 
Mixes. For additional information related to an invalid result, see the Decision Flowchart 
presented in Figure 26. 
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Figure 27. EGFR Plus RGQ PCR Kit Decision Flowchart. PC: Positive control. NTC: No template control. Ex2: EGFR exon 
2. CT: Cycle threshold. ΔCT: Delta CT. MT: Mutant. IC: Internal control. RM: Reaction mix. 

If the reason of the sample invalidity is not found: 

 Check that the samples have been handled and stored as described in section “Sample 
Storage and Handling”, page 25. 

 Re-extract the FFPE sample with more sections prior to retest. 
 Re-extract the FFPE sample by selecting a bigger tumor zone prior to retest. 
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For other explanations regarding the sample invalidity, please refer to the “Troubleshooting 
Guide” page 82. 

Validity of test sample 

If the EGFR qPCR run is valid, then validity of test samples may be assessed. 

The internal control (EGFR exon 2), assess in Yellow (HEX), must be valid for the sample results 
to be interpreted. A valid internal control indicates sufficient DNA input and quality as well as 
the absence of interfering substances.  

The internal controls of the test samples are valid, if the CT values in the Yellow (HEX) channel 
obtained for test samples are compliant with the validity criteria presented in Table 9 for FFPE 
samples and Table 10 for plasma samples. 

Table 9. Validity criteria for exon 2 Internal Control (IC) in FFPE samples 

 Fluorescence channel EGFR reaction mix  FFPE sample CT validity range  

 

Yellow (HEX) 

T790M & L861Q  

21.89; 31.10 

 

Insertions & G719X  

L858R & C797S  

Deletions & S768I  

 

Table 10. Validity criteria for exon 2 Internal Control (IC) in plasma samples 

 Fluorescence channel EGFR reaction mix  Plasma sample CT validity range  

 

Yellow (HEX) 

T790M & L861Q  

22.10; 31.18 

 

Insertions & G719X  

L858R & C797S  

Deletions & S768I  
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If the internal control in a given tube is invalid according to the criteria defined above, the test 
sample is deemed invalid. In case of invalidity, refer to the Decision Flowchart presented in 
Figure 26 (page 62). 

EGFR mutant call of test samples 

If the test sample is valid, the EGFR mutant call can be determined. 

An EGFR mutation presence is assessed based on the delta CT (∆CT) between the target 
amplification in Green (FAM) or Red (CFR610) channel and the internal control amplification 
in Yellow (HEX) channel for FFPE samples. Calculate the ∆CT value as follows:  

 ∆CT for Green target = Green (FAM) CT – Yellow (HEX) CT  

 ∆CT for Red target = Red (CFR610) CT – Yellow (HEX) CT 
 

An EGFR mutation presence is assessed based on the CT of the target amplification in Green 
(FAM) or Red (CFR610) channel for plasma samples.  

Compare the ∆CT or CT value of each test sample in each channel and each EGFR reaction 
mix (8 in total) with the estimated limit of detection of each target. See Table 11 for the FFPE 
samples and Table 12 for the plasma samples. If the ∆CT or CT value is lower or equal to the 
estimated limit of detection, the respective target is detected. 
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Table 11. Estimated limit of detection of each EGFR target in FFPE samples 

 Fluorescence channel EGFR reaction mix Target Estimated limit of detection (∆CT)  

 Green (FAM) T790M & L861Q  T790M 10.52  

 Insertions & G719X Insertions 9.48 

 L858R & C797S  L858R 9.18 

 Deletions & S768I  Deletions 10.49 

Red (CFR610) T790M & L861Q  L861Q 9.49 

Insertions & G719X G719X 8.04 

L858R & C797S  C797S 9.09 

Deletions & S768I  S768I 12.50 

   
Table 12. Estimated limit of detection of each EGFR target in plasma samples 

 Fluorescence channel EGFR reaction mix Target Estimated limit of detection (CT)  

 Green (FAM) T790M & L861Q  T790M 38.53  

 Insertions & G719X  Insertions 36.59 

 L858R & C797S  L858R 36.72 

 Deletions & S768I  Deletions 40.00 

Red (CFR610) T790M & L861Q  L861Q 34.81 

Insertions & G719X G719X 40.00 

L858R & C797S  C797S 34.96 

Deletions & S768I  S768I 40.00 

  The status of each test sample will be one of the following: 

 EGFR Mutation Detected 
 Mutation Not Detected 
 Invalid 
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Semi-quantitation of ccfDNA using the Rotor-Gene Q 

In addition to EGFR mutation detection, semi-quantitative analysis can be performed on 
ccfDNA extracted from Plasma samples for the mutations: G719X (A, C or S), S768I, T790M, 
C797S (a or b), L858R, and L861Q.  

Important point before starting 

 If you are performing semi-quantification of ccfDNA, it is required to run duplicates of the 
DNA standard dilutions for each assay and on each reaction plate. 

 Standards must be defined before a standard curve can be created. 
 Make sure that a plate layout has been created for each mix and reaction channel (e.g.: 

page1 of the “Sample Editing” window for quantitative analysis is “T790M&L861Q” 
while three pages will be created for semi-quantitative analysis) 

Procedure 

1. Prepare fresh serial dilutions of the external standards (e.g., EGFR DNA Reference 
Standard can be provided by Horizon Discovery). 

2. Vortex for at least 5 seconds, then centrifuge each dilution briefly before removing an 
aliquot for the next dilution. Use a new pipette tip for each dilution. 

Note: Take care not to introduce cross-contamination. 

3. Thaw the template nucleic acids. 

4. Follow steps 1–12 of “Protocol: EGFR mutation assessment by qPCR on Rotor-Gene Q 
instrument”, page 40. 

5. Ensure that the reaction Master Mix and template are thoroughly mixed. 

6. It is required to run duplicates of the DNA standard dilutions for each assay and on each 
reaction plate. 
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7. Continue with steps 13–28 of “Protocol: EGFR mutation assessment by qPCR on Rotor-
Gene Q instrument”, page 40. 

8. Proceed with data analysis. 

 

An example data analysis for semi-quantitation in T790M & L861Q Mix can be found in the 
next section. 

Data analysis for semi-quantification of ccfDNA using Rotor-Gene Q 

9. Open the Run file using the Rotor-Gene Q software. Go to File > Open > Browse to 
locate the saved file. 

10. Standards must be defined before a standard curve can be created. If the standards 
were defined before the run was started, proceed to step 12. 

11. Click the Samples to open the “Edit Samples” window (Figure 27). 

 
Figure 28. “Edit Samples” tool in the Rotor-Gene Q software. 

12. Instead of one plate layout per mix (e.g., Page 1/T790M & L861Q Mix, Page 2 
Insertions & G719X etc.), one plate layout per assay must be defined (e.g., Page 
1/T790M, Page 2/L861Q, Page 3/T790M & L861Q_IC). 

13. On Page 1/T790M of the “Edit Samples” window, select the sample type from the 
“Samples” list for each of the wells, e.g., Standard for T790M DNA standards, NTC for 
no template controls, Positive Control for EGFR Positive Control, Unknown for tested 
samples, and None for all empty wells and unanalyzed wells in this channel.  

In addition, change the “Selected column” to No for all empty wells and unanalyzed 
wells in this channel (Figure 28). 
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Figure 29. Editing the samples and units in the Rotor-Gene Q software. 

14. In the “Given Conc.” column, enter the DNA concentration of the T790M standards 
dilutions and define the unit (copies/reaction) using the drop-down list. Enter the sample 
name (e.g., Standard 1 20000 copies/reaction) (Figure 29). 

15. Click New twice to create two new pages, then check the Synchronize pages box (Figure 
29). 

Important: If you do not check the Synchronize pages box, the names of the wells will not 
be adopted for all channels. 
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Figure 30. Create a new sample page. 

16. On Page 2/L861Q of the Edit Samples window, clear the Synchronize pages box. Select 
None as sample type for T790M DNA standards (Figure 29). In the “Given Conc.” 
column, enter the L861Q DNA standard concentrations and define the unit 
(copies/reaction) from the drop-down list (Figure 29). 

Important: If you do not clear the Synchronize pages box, the same concentrations will 
be adopted for both T790M and L861Q standards, leading to an incorrect calculation of 
the unknown concentrations. 

17. On Page 3/T790M & L861Q_IC of the “Edit Samples” window, leave all DNA 
standards as Unknown in the “Type” column. 

18. Click More Options > Define Suitabilities. Select the Only display this sample page when 
analyzing data option (Figure 30). 
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Figure 31. Sample Page Suitabilities. 

19. Select the green channel for page 1/T790M, red channel for page 2/L861Q, and 
yellow channel for page 3/IC. Click Save and Close. Click Close to close the “Sample 
Page Suitabilities” dialog box (Figure 31). 
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Figure 32. Selecting color channels. 

20. Click OK in the “Edit Samples” dialog box. 

21. To analyze the samples, click Analysis. (Figure 32). 

 

 
Figure 33. Sample analysis in the Rotor-Gene Q software. 

22. On the “Quantitation tab”, select Page 1/T790M for the green channel, and click Show. 
Select Page 2/L861Q for the red channel, and Page 3/IC for the yellow channel, and 
click Show. If the “Autofind Threshold” window opens automatically, click Cancel. 
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The amplification plots for both the green and yellow channels are displayed in the 
“Quantitation Analysis” dialog box (Figure 33). 

 
Figure 34. Quantitation tab in the Analysis tool. 

23. Select the Dynamic Tube and Slope Correct options for each channel (Figure 24, page 
62). 

24. Click Take Off Adj. and adjust the cycle to be used as take off point. If take off point was 
calculated before cycle 15, use cycle 20 as the take-off point (Figure 24, page 62). 

25. Click Outlier Removal, set the value in the “NTC threshold” field to 10%, and ensure that 
Reaction Efficiency Threshold is disabled (Figure 25, page 62). 

26. Click Linear scale and set the threshold to 0.03 (Figure 24, page 62). The CT values are 
reported in the “Quantitation Results” window. 

27. The Standard Curves are shown in the “Standard Curve” windows for the green and the 
red channels. View the calculated regression line, slope (M), y-intercept (B), and R2 
values (Figure 34). 

  



 

  EGFR Plus RGQ PCR Kit Instructions for Use    03/2023 77 

 
Figure 35. Standard curves in the Rotor-Gene Q software. 

28. View the concentration of the unknown samples. 

The “Quantitation Results — Cycling A. Green” and the “Quantitation Results — Cycling 
A. Red” windows display data for selected wells, and respectively summarize the 
quantity of T790M and L861Q DNA present in the unknown samples. The unit is shown 
at the top of the column. 

29. To interpret the results, go to File > Save as > Excel Analysis Sheet. The results will be 
saved in *.csv format. To export a full report, go to File > Reports > Quantitation. 

 

Interpretation considerations 

General considerations for data analysis 

Real-time PCR data are produced as sigmoidal-shaped amplification plots (when using a linear 
scale), in which fluorescence is plotted against the number of cycles. 

The threshold cycle (CT value) serves as a tool for calculation of the starting template amount 
in each sample. This is the cycle in which there is the first detectable significant increase in 
fluorescence. 



 

78 EGFR Plus RGQ PCR Kit Instructions for Use   03/2023 

The optimal threshold setting depends on the reaction chemistries used for PCR. Therefore, an 
optimal threshold setting established for another kit may not be suitable for the EGFR Plus RGQ 
PCR Kit and may need to be adjusted. 

For DNA quantification using the EGFR Plus RGQ PCR Kit, the analysis settings must be 
adjusted for both reporter dyes. 

Standard curve 

The standard curve is the best fit for a linear regression to the standard dilution series data. 
The equation is in the form: y = mx + b (where x = log concentration and y = CT). 

Typically, the R2 ranges should be as close as possible to 1. If the values defers significantly 
from 1, see the “Troubleshooting Guide”, page 82, for more information. 

Slope 

The slope (m) describes the PCR efficiency. A slope of −3.3 indicates 100% PCR efficiency 
(i.e., the number of copies of amplification product is doubled at each cycle). Typically, the 
slope ranges between −3.0 to −3.6. If the values fall outside of this range, see the  
“Troubleshooting Guide”, page 82, for more information. 

Y-intercept 

The Y-intercept (b) indicates the expected CT value for a sample with Quantity = 1 (for example, 
1 copy/reaction). 



 

  EGFR Plus RGQ PCR Kit Instructions for Use    03/2023 79 

Internal control 

To analyze the internal control results, see “qPCR run validity” (page 65) and “Validity of test 
sample” (page 67). 

Semi-quantification of unknown samples 

The EGFR target quantification is automatically performed by the Rotor-Gene Q software. The 
EGFR Plus RGQ PCR Kit can quantify ccfDNA in 5 µL plasma samples. 

For ccfDNA, CT values (from Green or Red channels) are plotted against a standard curve 
obtained from linear regression of standards to calculate each EGFR target copies per 
reaction present in the sample. 
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Limitations 

This product is to be used for research use only, not to be used for diagnosis. No claim or 
representation is intended to provide information for the diagnosis, prevention, or treatment of 
a disease. 

The product is to be used by laboratory professionals trained in molecular biology procedures 
and trained in the use of the QIAsymphony SP system and Rotor-Gene Q instrument. 

The product is intended for use only on a Rotor-Gene Q real-time PCR cycler, 5plex HRM series.  

We recommend the use of the Deparaffinization Solution (including RNase A treatment), 
QIAamp DSP DNA FFPE Tissue Kit, QIAamp DSP Circulating Nucleic Acid Kit, QIAsymphony 
DSP DNA Mini Kit, and QIAsymphony DSP Circulating DNA Kit, or the technically equivalent 
non-DSP kits.  

Strict compliance with the EGFR Plus RGQ PCR Kit Instructions for Use is required for optimal 
results. Dilution of the reagents, other than as described in this handbook, is not recommended 
and will result in a loss of performance. All reagents supplied in the EGFR Plus RGQ PCR Kit are 
intended to be used solely with the other reagents supplied in the same kit. This may affect 
performance.  

It is important that the amount of gDNA from the FFPE sample is assessed prior to performing 
sample analysis using the EGFR Plus RGQ PCR Kit. The extraction procedure should be 
repeated if the gDNA quantity is not sufficient for mutation analysis. gDNA should be diluted 
if the concentration is too high for mutation analysis. 

Attention should be paid to expiration dates and storage conditions printed on the box and 
labels of all components. Do not use expired or incorrectly stored components. 
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Troubleshooting Guide 

This troubleshooting guide may be helpful in solving any problems that may arise. For more 
information, see also the Frequently Asked Questions page at our Technical Support Center: 
www.qiagen.com/FAQ/FAQList.aspx. The scientists in QIAGEN Technical Services are always 
happy to answer any questions you may have about either the information and/or protocols in this 
handbook or sample and assay technologies (for contact information, visit www.qiagen.com). 

 Comments and suggestions 

Run invalid due to invalid Positive Control  

a) One component of the 
reaction mix not added 

Check that the reaction mix has been prepared correctly.  
Check that all components of the qPCR reaction mix have been added.  
Repeat the qPCR run. 

b) Reaction mix degraded Kit has been frozen and thawed too many times, the kit contents were not 
stored at −30 to −15°C or the primer and probe mixes were not protected 
from light.  
Check the storage conditions and the expiration date (see the label) of the 
reagents and use a new kit.  
Repeat the qPCR run. 

c) Too low volume pipetted: 
pipetting volume may be 
incorrect 

Check pipetting scheme and setup of the reaction. Check 5 µL control was 
added. 
Check and recalibrate the pipettes before repeating the qPCR run. 

d) Fault with Rotor-Gene Q 
instrument 

Check instrument maintenance logs. 
Repeat the qPCR run. 

e) Error in Rotor-Gene Q 
instrument accessories 

The 72-Well Rotor may be incorrectly locked.  
Repeat the qPCR run. 

f) Strip tube and/or sample ID 
inversion 

Check the pipetting scheme and setup of the reaction.  
Repeat the qPCR run. 

http://www.qiagen.com/FAQ/FAQList.aspx
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 Comments and suggestions 

g) Controls missing or loaded in 
an incorrect position 

Make sure that the correct control is loaded in the correct position.  
Repeat the qPCR run. 

h) Insufficient mixing of control 
samples 

The thawing of the controls was incomplete before loading or the mixing of 
controls with the reaction mix (pipetting up and down) was not performed 
correctly.  
Repeat the qPCR run. 

i) Inefficient tube closing The tube was not efficiently capped, leading to evaporation during the qPCR 
run.  
Repeat the qPCR run. 

j) The storage conditions for one 
or more kit components did not 
comply with the instructions given 
in “Storage conditions” (page 
23) 

Check the storage conditions and the expiration date (see the kit label) of the 
reagents and use a new kit, if necessary. 

k) The EGFR Plus RGQ PCR Kit 
has expired 

Check the storage conditions and the expiration date (see the kit label) of the 
reagents and use a new kit, if necessary. 

l) Wrong software analysis 
settings 

Check software analysis settings. 
Repeat the qPCR run analysis. 

m) Wrong qPCR program 
settings 

Check qPCR program settings. Repeat the qPCR run 

n) Incorrect amplification curve 
(artefact) 

Check the corresponding curve for unusual curves (i.e., a straight line). 
Repeat the qPCR run. 

Run invalid due to amplification in No Template Control 

a) Cross-contamination or 
contamination of reagents 

Always handle samples, kit components and consumables in accordance with 
recommended practices to prevent carryover contamination.  
Make sure tips are changed between pipetting different reagents or when 
loading different tubes. Prepare the qPCR reaction mix with dedicated 
material (pipettes, tips, etc.).  
Prepare the qPCR reaction mix and NTC reaction in a dedicated area where 
no DNA matrices (DNA, plasmid or PCR products) are introduced.  
If cross contamination is identified, replace all reagents. 
Repeat the qPCR run.  
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b) Incorrect amplification curve 
(artefact) 

Check the corresponding curve for unusual curves (i.e., a straight line). 
Repeat the qPCR run. 

c) Strip tube and/or sample ID 
inversion 

Check the pipetting scheme and setup of the reaction.  
Repeat the qPCR run.  

d) Wrong software analysis 
settings 

Check software analysis settings. 
Repeat the qPCR run analysis. 

Sample invalid due to no or low amplification in Internal Control 

a) Too low sample DNA 
concentration 

The EGFR Plus RGQ PCR Kit is optimized for a 5 ng/µL working concentration 
(DNA from FFPE) and 5 µL pure extract of ccfDNA from plasma samples.  
Check the concentration (for FFPE). 
Repeat the qPCR step for the sample. 

b) Poor DNA sample quality Check the concentration (for FFPE).  
Repeat the qPCR step with an alternative sample (ideally freshly cut). 
Repeat the run using a higher sample concentration. 
Note: Testing higher concentration of gDNA may enable an earlier exon2 CT, 
but will increase the risk of inhibition. Therefore, the CT exon 2 may be later 
than with a lower concentration. 

c) Presence of inhibitor in the 
sample 

Dilute the sample and repeat the run with lower concentration of sample.  
Note: Testing a lower concentration may give an earlier exon 2 signal if 
inhibitors were present in the sample at 5 ng/µL. 
Re-extract the sample (FFPE) with more sections and repeat the run.  
Note: By eluting more sections in the same volume, the inhibitor concentration 
may be increased when the sample is normalized at 5 ng/µL. 

d) Too low volume pipetted: 
pipetting volume may be 
incorrect 

Check pipetting scheme and setup of the reaction. Check 5 µL of sample was 
added. 
Check and recalibrate the pipettes before repeating the qPCR run. 

e) Inefficient tube closing The tube was not efficiently capped, leading to evaporation during the qPCR 
run.  
Repeat the qPCR step for the sample. 
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f) The storage conditions for one 
or more kit components did not 
comply with the instructions given 
in “Storage conditions” (page 
23) 

Check the storage conditions and the expiration date (see the kit label) of the 
reagents and use a new kit, if necessary. 

g) The EGFR Plus RGQ PCR Kit 
has expired 

Check the storage conditions and the expiration date (see the kit label) of the 
reagents and use a new kit, if necessary. 

h) Wrong software analysis 
settings 

Check software analysis settings. Repeat the qPCR run analysis. 

i) Wrong qPCR program settings Check qPCR program settings. Repeat the qPCR run. 

j) Abnormal fluorescence Do not write on the tubes. Use caution when handling tubes. Wear gloves. 
Check visually the PCR reaction tube for the presence of black magnetic 
particles (originating from automated QIAsymphony extraction). Particles may 
be removed as described in the respective extraction kit handbooks. 

Sample invalid due to early amplification of the Internal Control in samples 

a) Too high sample DNA 
concentration 

The EGFR Plus RGQ PCR Kit is optimized for a 5 ng/µL working concentration 
(FFPE). 
For gDNA from FFPE: Check DNA concentration. If DNA is not at this 
concentration, dilute DNA. 
For ccfDNA from plasma: Dilute the sample. 
Repeat the qPCR step for the sample. 

b) Too high volume pipetted: 
Pipetting volume may be 
incorrect 

Check pipetting scheme and setup of the reaction. Check 5 µL sample was 
added. 
Check and recalibrate the pipettes before repeating the qPCR run for the 
sample. 

c) The amplification curve may 
be incorrect 

Check the corresponding curve for false positives (i.e., a straight curve 
instead of exponential amplification).  
Repeat the qPCR step for the sample. 

d) Abnormal fluorescence Do not write on the tubes. Use caution when handling tubes. Wear gloves. 
Check visually the PCR reaction tube for the presence of black magnetic 
particles (originating from automated QIAsymphony extraction). Particles may 
be removed as described in the respective extraction kit handbooks. 
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Frequent failure due to high background amplification below the estimated limit of detection (ΔCT) 

Fault with Rotor-Gene Q 
instrument 

Check instrument maintenance logs. 
For example, lens misalignment may lead to higher background. If lens 
alignment is not part of your maintenance plan, please contact QIAGEN 
Technical Services for more information and potential intervention. 

Run failure due to inconsistent fluorescence signal in controls and/or samples (over all tubes) 

a) Fault with Rotor-Gene Q 
instrument accessories 

Check instrument maintenance logs. Faulty rotor disc. 

b) Abnormal fluorescence Do not write on the tubes. Use caution when handling tubes. Wear gloves. 
Check visually the PCR reaction tube for the presence of black magnetic 
particles (originating from automated QIAsymphony extraction). Particles may 
be removed as described in the respective extraction kit handbooks. 

No linearity in ratio of CT value/crossing point to log of the template amount 

Amount of template in unknown 
sample too high 

Linearity is guaranteed within the range of the standard curve. When signals 
are appearing at very early CT values, dilute the sample and repeat the 
reaction. 

Slope of the standard curve used for the semi quantification is not between −3.0 and −3.6 or R2 value differs 
significantly from 1 

a) Too high/low volume 
pipetted: pipetting volume may 
be incorrect 

Check pipetting scheme and setup of the reaction. Check 5 µL of each serial 
dilution point was added. 
Check and recalibrate the pipettes before repeating the qPCR run. 

b) Problem with dilution of 
standards or wrong serial 
dilution of the reference material  

Ensure that the DNA standard is completely thawed and mixed thoroughly 
before use. 
Ensure dilutions of the DNA standard are mixed thoroughly before removing 
each aliquot for the serial dilution. 
Do not use a sample volume other than 5 µL for plasma and for FFPE (5 
ng/µL). 
Verify all calculations, and repeat dilution of the DNA standard. 
Change pipet tips between each dilution step. 
Repeat the serial dilution and the qPCR run. 
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c) Run is invalid Check the run validity.  
Check the Control (PC and NTC) validity. 

d) The EGFR Plus RGQ PCR Kit is 
expired 

Check the storage conditions and the expiration date (see the kit label) of the 
reagents and use a new kit, if necessary. 

e) The amplification curve may 
be incorrect 

Check the corresponding curve (i.e., a straight curve instead of exponential 
amplification). 
Repeat the qPCR step. 

f) Wrong standard identification 
and/or concentration entered in 
the Rotor-Gene Q software 

Check that Standards are identified as Standards. 
Check that the correct concentration is assigned to each standard.  
Repeat the qPCR analysis. 

g) Contamination of real-time 
cycler 

Decontaminate the real-time cycler according to the manufacturer’s 
instructions. 
Repeat the experiment. 

h) Fault with Rotor-Gene Q 
instrument 

Check instrument maintenance logs.  
Repeat the qPCR step. 

i) Wavy curve at high template 
amounts for highly concentrated 
targets 

In the analysis settings, reduce the number of cycles used for background 
calculation or reduce the amount of template. 

j) Abnormal fluorescence Do not write on the tubes. Use caution when handling tubes. Wear gloves. 

k) Statistical variation Some variation in the reaction is normal, particularly when the DNA target is 
present at low copy number. Perform at least duplicates for the standard 
curve to minimize the effect of this variation. Remove the lowest concentrated 
dilution of the DNA standard from the standard curve by changing the sample 
type to “Unknown”. 

For troubleshooting information relating to DNA extraction kits and associated reagents to be 
used, refer to the respective kit handbooks. 

For troubleshooting information relating to the QIAsymphony SP instrument and Rotor-Gene Q 
instrument, refer to the respective user manuals. 
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Symbols 
The following symbols may appear in the instructions for use or on the packaging and labeling: 

Symbol Symbol definition 

 <N> 
Contains reagents sufficient for <N> reactions 

 Use by 

 Catalog number 

 Lot number 

 Material number (i.e., component labeling) 

 Components  

 Contains  

 Number  

 Global Trade Item Number 

 
Temperature limitation 

 
Manufacturer 
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Symbol Symbol definition 

 
Consult instructions for use 

 

Keep away from sunlight 

 

Warning/caution 
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Contact Information 

For technical assistance and more information, please see our Technical Support Center at 
www.qiagen.com/Support, call 00800-22-44-6000, or contact one of the QIAGEN Technical 
Service Departments or local distributors (see back cover or visit www.qiagen.com). 
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Product Contents Cat. no. 

EGFR Plus RGQ PCR Kit (24) For 24 reactions: T790M & L861Q Mix, 
Insertions & G719X Mix, L858R & 
C797S Mix, Deletions & S768I Mix, 
PCR Master Mix, EGFR Positive Control, 
RNase/DNase-free Water 

874601 

 Rotor-Gene Q and accessories  

Rotor-Gene Q 5plex HRM 
System 

Real-time PCR cycler and High Resolution 
Melt analyzer with 5 channels (Green, 
Yellow, Orange, Red, Crimson) plus 
HRM channel, laptop computer, 
software, accessories, 1-year warranty 
on parts and labor, installation and 
training included 

 9001650 

Rotor-Gene Q 5plex HRM 
Platform 

Real-time PCR cycler and High Resolution 
Melt analyzer with 5 channels (Green, 
Yellow, Orange, Red, Crimson) plus 
HRM channel, laptop computer, 
software, accessories, 1-year warranty 
on parts and labor, installation and 
training not included 

9001580 

Loading Block 72 x 0.1 mL 
Tubes 

Aluminum block for manual reaction 
setup with a single-channel pipette in 
72 x 0.1 mL tubes 

9018901 

72-Well Rotor  For holding Strip Tubes and Caps 0.1 ml; 
requires Locking Ring 72-Well Rotor  

9018903 
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Locking Ring 72-Well Rotor  For locking Strip Tubes and Caps, 0.1 
mL in the 72-Well Rotor  

9018904 

Rotor Holder  Metal free-standing holder for 
assembling tubes and Rotor-Discs® into 
rotors 

9018908 

Strip Tubes and Caps, 0.1 mL 
(250) 

250 strips of 4 tubes and caps for 1000 
reactions  

981103 

Strip Tubes and Caps, 0.1 mL 
(2500) 

10 x 250 strips of 4 tubes and caps for 
10,000 reactions 

981106 

QIAsymphony SP   

QIAsymphony SP System QIAsymphony sample prep module: 
includes installation and training, 1 year 
warranty on parts and labor 

9001751  

QIAsymphony SP QIAsymphony sample prep module: 
includes 1-year warranty on parts and 
labor 

9001297 

Related products   

Deparaffinization Solution 
(16 mL) 

2 x 8 mL Deparaffinization Solution 19093 

Deparaffinization Solution 
(50 mL) 

1 x 50 mL Deparaffinization Solution 939018 

QIAamp DSP DNA FFPE Tissue 
Kit (50) 

For 50 DNA preps: 50 QIAamp 
MinElute® Columns, Proteinase K, Buffers 
and Collection Tubes (2 mL) 

60404 

QIAamp DNA FFPE Tissue Kit 
(50) 

For 50 DNA preps: 50 QIAamp 
MinElute Columns, Proteinase K, Buffers 
and Collection Tubes (2 mL) 

56404 
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QIAamp DSP Circulating NA 
Kit (50) 

For 50 preps: QIAamp Mini columns, 
Buffers, Carrier DNA, QIAGEN 
Proteinase K and tubes 

61504 

QIAamp Circulating NA Kit 
(50) 

For 50 preps: QIAamp Mini Columns, 
Tube Extenders (20 mL), QIAGEN 
Proteinase K, Carrier RNA, Buffers, 
VacConnectors, and Collection Tubes 
(1.5 mL and 2 mL) 

55114 

QIAsymphony DSP DNA Mini 
Kit (192) 

For 192 preps of 200 µL each: Includes 
2 reagent cartridges and enzyme racks 
and accessories 

937236 

QIAsymphony DNA Mini Kit 
(192) 

For 192 preps of 200 µL each: Includes 
2 reagent cartridges and enzyme racks 
and accessories 

931236 

QIAsymphony DSP Circulating 
DNA Kit (192) 

Reagent cartridges, accessories and 
proteinase K vials for 192 preps of 
2000 µL or 4000 µL each 

937556 

RNase A (17,500 U)  2.5 mL (100 mg/mL; 7000 units/mL, 
solution) 

19101 

Buffer ATL (4 x 50 mL) 4 x 50 mL lysis buffer 939016 
 
 

For up-to-date licensing information and product-specific disclaimers, see the respective 
QIAGEN kit handbook or user manual. QIAGEN kit handbooks and user manuals are 
available at www.qiagen.com or can be requested from QIAGEN Technical Services or your 
local distributor. 
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Document Revision History 
Revision Description 

R1, April 2022 Initial Release 

R2, March 2023 Added “Sample Types & Layout in Protocol: EGFR 
mutation assessment by qPCR on Rotor-Gene Q 
instrument. Edited according to new brand template. 
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Limited License Agreement for EGFR Plus RGQ PCR Kit 
Use of this product signifies the agreement of any purchaser or user of the product to the following terms: 
1. The product may be used solely in accordance with the protocols provided with the product and this handbook and for use with components contained in the panel 
only. QIAGEN grants no license under any of its intellectual property to use or incorporate the enclosed components of this panel with any components not included 
within this panel except as described in the protocols provided with the product, this handbook, and additional protocols available at www.qiagen.com. Some of 
these additional protocols have been provided by QIAGEN users for QIAGEN users. These protocols have not been thoroughly tested or optimized by QIAGEN. 
QIAGEN neither guarantees them nor warrants that they do not infringe the rights of third-parties.  
2. Other than expressly stated licenses, QIAGEN makes no warranty that this panel and/or its use(s) do not infringe the rights of third-parties. 
3. This panel and its components are licensed for one-time use and may not be reused, refurbished, or resold. 
4. QIAGEN specifically disclaims any other licenses, expressed or implied other than those expressly stated. 
5. The purchaser and user of the panel agree not to take or permit anyone else to take any steps that could lead to or facilitate any acts prohibited above. QIAGEN 
may enforce the prohibitions of this Limited License Agreement in any Court, and shall recover all its investigative and Court costs, including attorney fees, in any 
action to enforce this Limited License Agreement or any of its intellectual property rights relating to the panel and/or its components. 
For updated license terms, see www.qiagen.com 
 
Trademarks: QIAGEN®, Sample to Insight®, QIAamp®, QIAsymphony®, MinElute®, Rotor-Gene®, Rotor-Disc® (QIAGEN Group); CAL Fluor® (Biosearch 
Technologies, Inc.); FAM™, HEX™ (Thermo Fisher Scientific Inc). 03/2023 HB-2959-003 © 2023 QIAGEN, all rights reserved.
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